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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description UMA Discrete

Product Name HP ProBook 4545s Notebook PC √ √

 AMD A8-4500M, 2.8-GHz Max/1.9-GHz Base, 4-MB L2 cache, quad-core, 35W

Graphics: HD 7640G

√ √

 AMD A6-4400M, 3.20-GHz Max/2.7-GHz Base, 1-MB L2 cache, dual-core, 35W

Graphics: HD 7520G

√ √

 AMD A4-4300M, 3.0-GHz Max/2.5-GHz Base, 1-MB L2 cache, dual-core, 35W

Graphics: HD 7420G

√ √

Fusion Controller
Hub (Chipset)

AMD A70M FCH (Fusion Controller Hub) √ √

Graphics AMD UMA

Processor-specific, see Processors.

√  

 AMD Discrete Graphics:

A8-4500M, Graphic branding HD 7640G + AMD RadeonTM HD 7650M

or

A6-4400M, Graphic branding HD 7520G + AMD Radeon HD 7650M

-or-

A4-4300M, Graphic branding HD7420G + AMD Radeon HD 7650M

 √

Panel All display assemblies include 2 wireless local area network (WLAN) antennas

All displays are LED backlit

√ √

 39.6-cm (15.6-inch) HD, 1366x768, Anti-glare, without web cam √ √

 39.6-cm (15.6-inch) HD, 1366x768, Anti-glare, with web cam √ √

Memory Two customer-accessible/upgradeable memory module slots supporting up to 8
GB of RAM

√ √

 Supports dual-channel memory √ √

 PC3-10600, 1333-MHz, DDR3 √ √

 Supports the following configurations:

● 8192 MB (4096 × 2) (dual channel)

● 6144 MB (4096 + 2048) (dual channel)

● 4096 MB (2048 × 2) (dual channel)

● 4096 MB (4096 × 1)

● 2048 MB (2048 × 1)

√ √

Hard drives Supports 7-mm/9.5-mm/12.7-mm, and 2.5-in SATA hard drives with HP 3D
DriveGuard

√ √
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Category Description UMA Discrete

 Customer-accessible √ √

 Supports the following drives:

● 750-GB, 7200-rpm, 2.5-in

● 750-GB, 5400 rpm, 2.5 in

● 640-GB, 5400-rpm, 2.5-in

● 500-GB, 7200-rpm, 2.5-in

● 320-GB, 7200-rpm, 2.5–in

√ √

Fixed optical
drives

Supports the following 12.7-mm SATA optical drives:

● DVD-ROM

● DVD+/-RW SuperMulti DL

● Blu-ray ROM DVD+/-RW SuperMulti DL

√ √

 Supports no optical drive option √ √

Audio/Visual Integrated dual-array microphone (webcam models only) √ √

 Integrated mono (non-webcam models) √ √

 Stereo speakers (2) √ √

 Integrated webcam (720p HD) √ √

 Supports no camera option √ √

 Headphone and microphone jacks √ √

Ethernet Realtek RTL8151FH-CG 10/100/1000 √ √

 S3/S4/S5 wake on LAN (AC mode only) √ √

 Ethernet cable not included √ √

Wireless Integrated WLAN options by way of wireless module: √ √

 Two WLAN antennas built into display assembly √ √

 Supports “no WLAN” option √ √

 Supports the following WLAN formats:

● Ralink RT5390F 802.11 b/g/n 1×1 PCIe HMC

● Ralink RT3290LE 802.11 b/g/n 1x1 WiFi and Bluetooth 4.0 Combo Adapter

● Ralink RT5390R 802.11 b/g/n 1x1 WiFi Adapter

● Broadcom 4313GN 802.11 b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo
Adapter

● Atheros 9485GN 802.11 b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo
Adapter

● Atheros AR9485 802.11 b/g/n WiFi Adapter

● Atheros AR9462 802.11 a/b/g/n 2x2 Bluetooth 4.0 Combo

● Atheros AR9465 802.11 b/g/n 1x1 WiFi with Bluetooth 4.0 Combo Adapter

√ √

 Integrated personal area network (WPAN) options by way of Bluetooth®
module:

√ √
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Category Description UMA Discrete

 Bluetooth 4.0 only supported by combo card √ √

External media
card

6-in-1 Digital Media Reader Slot. Supports SD,SDHC, SDXC, MMC, MMC+ and
Memory Stick

√ √

Ports Audio-in (stereo microphone) √ √

 Audio-out (stereo headphone) √ √

 RJ-45 (Ethernet, includes link and activity lights) √ √

 USB 2.0 (2) √ √

 USB 3.0 (2) √ √

 VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-GHz (hot
plug/unplug with auto-detect)

√ √

 HDMI √ √

 Multi-pin AC port √ √

Keyboard/
pointing devices

Full-sized keyboard with numeric keypad √ √

 TouchPad includes: supports 2-way scroll with legend, taps enabled by default,
2-finger scrolling and zoom enabled by default

√ √

Power
requirements

Smart AC adapter with localized cable plug support (3-wire plug with ground pin): √ √

 90-W  √

 65-W √  

 Battery √ √

 9-cell, 93-Wh Li-ion battery √ √

 6-cell, 47-Wh Li-ion battery √ √

Security Integrated fingerprint reader √ √

 Support Kensington security lock √ √

 Support no fingerprint reader option √ √

Operating system Preinstalled:   

 Windows 7 Professional 64 with Microsoft Basics √ √

 Windows 7 Home Premium 64 with Microsoft Basics √ √

 Windows 7 Professional 32 with Microsoft Basics (Japan only) √ √

 Novell™: SuSE Linux™ 64 bit SP2 (excludes Japan) √ √

 FreeDOS (excludes Japan) √ √

 Windows 8 ML 64 with Microsoft Office Basics √ √

 Windows 8 Pro 64 with Microsoft Office Basics √ √

 Preinstalled with Microsoft Office: √ √

 Windows 7 Professional 64 with Microsoft Office 2010 Starter (excludes Japan) √ √
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Category Description UMA Discrete

 Windows 7 Professional 64 with Microsoft Office 2010 Starter PPP (EDGI) √ √

 Windows 7 Professional 64 with Microsoft Office 2010 Professional (Japan only) √ √

 Windows 7 Professional 64 with Microsoft Office 2010 Personal (Japan only) √ √

 Windows 7 Professional 64 with Microsoft Office 2010 Starter - MSNA √ √

 Windows 7 Professional 64 with Microsoft Office 2010 Home & Business (Japan
only)

√ √

 Windows 7 Home Premium 64 with Microsoft Office 2010 Starter (excludes
Japan)

√ √

 Windows 7 Home Premium 64 with Microsoft Office 2010 Starter - PPP (EDGI) √ √

 Windows 7 Home Premium 64 with Microsoft Office 2010 Professional (Japan
only)

√ √

 Windows 7 Home Premium 64 with Microsoft Office 2010 Personal (Japan only) √ √

 Windows 7 Home Premium 64 with Microsoft Office 2010 Home & Business
(Japan only)

√ √

 Windows 7 Home Basic 64 with Microsoft Office 2010 Starter – PPP (EDGI) √ √

 Windows 7 Home Basic 64 with Microsoft Office 2010 Starter (excludes Japan) √ √

 Windows 7 Professional 32 with Microsoft Office 2010 Personal (Japan only) √ √

 Windows 7 Professional 32 with Microsoft Office 2010 Home & Business (Japan
only)

√ √

 Windows 7 Professional 32 with Microsoft Office 2010 Professional (Japan only) √ √

 Windows 8 ML 64 with Office 2010 Transition OPK (excludes Japan) √ √

 Windows 8 EM 64 with Office 2010 Transition OPK (excludes Japan) √ √

 Windows 8 ML 64 with Office 2010 Personal (Japan only) √ √

 Windows 8 ML 64 with Office 2010 Home & Business (Japan only) √ √

 Windows 8 ML 64 with Office 2010 Professional (Japan only) √ √

 Windows 8 Pro 64 with Office 2010 Transition OPK (excludes Japan) √ √

 Windows 8 Pro 64 with Office 2010 Personal (Japan only) √ √

 Windows 8 Pro 64 with Office 2010 Home & Businessl (Japan only) √ √

 Windows 8 Pro 64 with Office 2010 Professional (Japan only) √ √

Restore Media: √ √

 Windows 7 Professional 64 √ √

 Windows 7 Home Basic 64 √ √

 Windows 7 Home Premium 64 √ √

 DRDVD Win 8 √ √

 Win 7 Pro 32 √ √

 Win 8 ML 64 √ √
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Category Description UMA Discrete

 Win 8 Pro 64 √ √

 DRDVD Windows 7 √ √

 Web-only support:   

 Windows XP Professional √ √

 Windows 7 Home Basic 32 √ √

 Windows 7 Home Premium 32 √ √

 Windows 7 Professional 32 √ √

 Certified:   

 Microsoft WHQL √ √

 SuSE Linux Enterpriise (SLED) SP2 64 bit √ √

Serviceability End-user replaceable parts:   

 AC adapter √ √

 Battery (system) √ √

 Hard drive √ √

 Optical drive √ √

 Memory module √ √

 WLAN module √ √

 Keyboard √ √
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2 External Component Identification

Top

TouchPad

Component Description

(1)  TouchPad on/off button Turns the TouchPad on and off.

(2)  TouchPad zone Moves the pointer and selects or activates items on the
screen.

(3)  Left TouchPad button Functions like the left button on an external mouse.

(4)  Right TouchPad button Functions like the right button on an external mouse.

6 Chapter 2   External Component Identification



Lights

Component Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep/Suspend state,
which is an energy-saving mode. The computer shuts
off power to the display and other unneeded
components.

● Off: The computer is off or in Suspend/Hibernation.
Hibernation is an energy-saving mode that uses the
least amount of power.

(2)  Caps lock light On: Caps lock is on.

(3) Web browser light ● On: The computer is on.

● Off: The computer is off or in Suspend/Hibernation.
Hibernation is an energy-saving mode that uses the
least amount of power.

(4) Wireless light ● White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.

● Amber: All wireless devices are off.

(5)  TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.
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Buttons, speakers, and fingerprint reader (select models only)
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Component Description

(1) Power button ● When the computer is off, press the button to turn on
the computer.

● When the computer is on, press the button briefly to
initiate Sleep/Suspend.

● When the computer is in the Sleep/Suspend state,
press the button briefly to exit Sleep/Suspend.

● When the computer is in Suspend/Hibernation, press
the button down briefly to exit Suspend/Hibernation.

If the computer has stopped responding and operating
system shutdown procedures are ineffective, press and hold
the power button down for at least 5 seconds to turn off the
computer.

CAUTION: Pressing and holding down the power button
will result in the loss of unsaved information.

To learn more about your power settings:

Windows 7:

1. Select Computer > Control Panel.

2. In the left pane, click System, and then click Power
Management in the right pane.

Windows 8:

From the Start screen, type power options. Click
Settings, and then select Power Options from the options
displayed.

SUSE Linux:

1. Select Computer > Control Center.

2. In the left pane, click System, and then click Power
Management in the right pane.

(2)  Speakers (2) Produce sound.

(3) Web browser button Opens the default Web browser.

(4) Wireless button Turns the wireless feature on or off but does not establish a
wireless connection.

NOTE: A wireless connection may be established if one
has been previously configured.

(5)  Fingerprint reader (select models only) Allows a fingerprint logon to the operating system, instead of
a password logon.
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Keys

Component Description

(1)  esc key Displays system information when pressed in combination
with the fn. key

(2)  fn key Executes frequently used system functions when pressed
in combination with a function key, the num lk key or the
esc key.

(3) Windows 7 logo key Displays the operating system Start screen.

Windows 8 logo key

(4)  Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(5) Windows applications key Windows 7:

Displays a shortcut menu for items beneath the cursor.

Windows 8:

Displays a shortcut menu for items beneath the cursor.

Displays the Apps bar.

SUSE Linux:

Displays a shortcut menu for items beneath the cursor.

(6)  num lk key Alternates between the navigational and numeric functions
of the integrated numeric keypad. .

NOTE: They keypad function that is active when the
computer is turned off is reinstated when the computer is
turned back on.

(7)  Integrated numeric keypad When num lk has been enabled, it can be used like an
external numeric keypad.
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Front

Component Description

(1) Hard drive light ● Blinking White: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
hard drive.

(2)  Media Card Reader Supports the following digital card formats:

● Memory Stick Pro

● Memory Stick Duo Pro (needs an adapter)

● MultiMediaCard (MMC)

● MultiMediaCardplus (MMC+)

● Secure Digital (SD) Card

● Secure Digital HIgh Capacity (SDHC) Card

● Secure Digital Extra Capacity (SDXC) Card

(3) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety, and Environmental Notices.

Windows 8: To access this guide, select the HP Support
Assistant app on the Start screen, select My computer,
and then select the User guides.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

(4) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.
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Right

Component Description

(1) USB 2.0 ports (2) Connect optional USB devices.

(2)  Optical drive (select models only) Reads to an optical disc.

NOTE: On select models, the optical drive also writes to
an optical disc.

(3)  Optical drive light (select models only) ● On: The optical drive is being accessed.

● Off: The optical drive is idle.

(4)  Optical drive eject button (select models
only)

Releases the optical drive disc tray.

12 Chapter 2   External Component Identification



Left

Component Description

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2)  Power connector Connects an AC adapter.

(3) AC adapter/battery light ● Amber: The computer is connected to external power
and the battery is charged from 0 to 90 percent.

● White: The computer is connected to external power
and the battery is charged from 90 to 99 percent.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the AC
adapter/battery light begins blinking rapidly.

● Off: The battery is fully charged.

(4)  Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) External monitor port Connects an external VGA monitor or projector.

(6) RJ-45 (network) jack Connects a network cable.

(7) HDMI port Connects an optional video or audio device, such as a high-
definition television, or any compatible digital or audio
device.

(8) USB 3.0 ports (2) Connect optional USB devices.
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Display
NOTE: Refer to the illustration that most closely matches your computer.

Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(2) Internal microphone(s) (1 or 2 depending on
model)

Record sound.

(3) Webcam light (select models only) On: The webcam is in use.

(4) Webcam (select models only) Records video and captures still photographs.

Windows 8: For information on using the webcam, access Help
and Support. From the Start screen, type help, and then select
Help and Support.

(5) Internal display switch Turns off the display or initiates Sleep if the display is closed
while the power is on.

NOTE: The display switch is not visible from the outside of the
computer.

*The antennas are not visible on the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region.

For Windows 8: To access this guide, select the HP Support Assistant app on the Start screen, select My computer, and
then select the User guides.
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Bottom
NOTE: Your computer may look slightly different from the illustration in this section.

Component Description

(1) Battery and service door release latches ● Release the battery from the battery bay by sliding
the release latches one time.

● When the battery has been removed from the battery
bay, release the service door from the computer by
sliding the release latches a second time.

(2)  Battery bay Holds the battery.

(3) Service door Protects the hard drive bay, the wireless LAN (WLAN)
module slot, and the memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore computer
functionality, and then contact support.

Windows 7: Contact is made through Help and Support.

Windows 8: Contact is made through Help and Support.
From the Start screen, type help, and then select Help
and Support.

SUSE Linux: Contact is made through Linux Help

(4)  Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.
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Identifying the bottom parts of the computer
NOTE: The service door has been removed in the following illustration.

Component Description

(1)  Memory modules

(2)  Hard drive

(3)  WLAN module slot (select models only)
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

● Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.
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PCID label
The PCID label provides the information required to properly reset the notebook firmware (BIOS)
back to the factory shipped specifications when replacing the system board. The following image
illustrates label location.

NOTE: Computer layout may vary from that shown.

For Windows 7 and SUSE Linux models:

For Windows 8 models: 
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Computer major components

Item Description Spare part number

(1) Display panel  

 39.6-cm (15.6-inch) HD, Anti-glare, with webcam 683597-001
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Item Description Spare part number

 39.6-cm (15.6-inch) HD, Anti-glare, without webcam 683596-001

(2) Keyboard (includes cable)  

 For use with models using Windows 7

NOTE: For a detailed list of available keyboards, see Sequential part number listing
on page 26.

683491-xxx

 For use with models using Windows 8

NOTE: For a detailed list of available keyboards, see Sequential part number listing
on page 26.

702237-xxx

(3) Top cover (includes TouchPad board with cable)  

 With a fingerprint reader (includes fingerprint reader board and screw) 683506-001

 Without a fingerprint reader board. Includes:ESD board screws, fingerprint dummy with
screws, and fingerprint bracket with screws.

683507-001

(4) Audio board 683475-001

(5) Power button board 683486-001

(6) Speaker assembly 683505-001

(7) RTC battery 683601-001

(8) System board (includes replacement thermal material)  

 For use in models with 1-GB of discrete memory using Windows 7 683598-001

 For use in models with 1-GB of discrete memory using Windows 8 Std 683598-501

 For use in models with 1-GB of discrete memory using Windows 8 Pro 683598-601

 For use in models with 2-GB of discrete memory using Windows 7 683599-001

 For use in models with 2-GB of discrete memory using Windows 8 Std 683599-501

 For use in models with 2-GB of discrete memory using Windows 8 Pro 683599-601

 For use in models with UMA graphics using Windows 7 683600-001

 For use in models with UMA graphics using Windows 8 Std 683600-501

 For use in models with UMA graphics using Windows 8 Pro 683600-601

(9) Fingerprint reader module (includes cable) 683485-001

(10) Optical drive extender board 683498-001

(11) Metal heat shield 687696-001

(12) Hard drive extender board 683487-001

(13) Base enclosure 683476-001

(14) Battery, Li-ion  

 9-cell (93 WHr, 2.8 Ah) 633809-001

 6-cell (47 WHr, 2.2 Ah) 633805-001

(15) WLAN module

 Atheros 9485GN 802.11b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001
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Item Description Spare part number

 Atheros AR9485 802.11b/g/n WiFi Adpater HMC 675794-001

 Atheros AR9462 802.11 a/b/g/n 2x2 Bluetooth 4.0 Combo 676786-001

 Atheros AR9565 802.11 b/g/n + Bluetooth 4.0 Combo Adapter 690019-001

 Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

 Ralink RT5390F 802.11 b/g/n 1x1 PCIe C 670691-001

 Ralink RT3290LE 802.11 b/g/n 1x1 WiFi and Bluetooth 4.0 Combo Adapter 690020-001

 Ralink RT5390R 802.11 b/g/n 1x1 WiFi Adapter 691415-001

(16) USB connectors with cable (part of Cable Kit 683477-001)  

(17) Memory modules (PC3-12800, 1600-MHz, DDR3)

 4-GB 641369-001

 2-GB 652972-001

(18) Optical drive (includes bracket, bezel, and screws)

 Blu-ray ROM DVD±RW SuperMulti DL Drive 683499-001

 DVD-ROM ±RW Double Layer 683500-001

 DVD-ROM 700845-001

(19) Processor (includes thermal material)  

 AMD A4-4300M (3.0-GHz/2.5-GHz, 1-MB L2 cache) 685990-001

 AMD A6-4400M (3.0-GHz/2.6-GHz, 4-MB L2 cache) 683047-001

 AMD A8-4500M (3.0-GHz/2.1-GHz, 2-MB L2 cache) 683048-001

(20) Heat sink (includes replacement thermal material — thermal grease for CPU and thermal
pad for VGA)

 

 For use in models with discrete graphics 683602-001

 For use in models with UMA graphics 683603-001

(21) Fan 683484-001

(22) Hard drive  

 750-GB, 7200-rpm (2.5 in) 633252-001

 750-GB, 5400 rpm (2.5 in) 634250-001

 640-GB, 5400-rpm (2.5 in) 669300-001

 500-GB, 7200 rpm (2.5 in) 634925-001

 320-GB, 7200-rpm (2.5 in) 641672-001

(23) Bottom door 690978-001
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Display components

Item Description Spare part number

(1) Display hinge covers (part of Display hinge kit 683480-001)  

(2) Display bezel  

 For use with models with a webcam 683478-001

 For use with models without a webcam 683479-001

(3) Webcam module 683508-001

 Microphone module (not illustrated) 647675-001

(4) Display hinges (includes left and right hinges, plastic hinge covers, and LCD rubbers) 683480-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit 683501-001

(1) Optical drive protective insert

(2) Secure Digital card protective insert
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Cable Kit

Item Description Spare part number

 Cable Kit 683477-001

(1) Battery cable  

(2) DC-in cable

(3) Audio cable  

(4) USB module with cable  
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Mass storage devices

Description Spare part number

Optical drives

Blu-ray BD-R/RE DVD±RW SuperMulti DL Drive 683499-001

DVD-ROM with SuperMulti DL Drive 683500-001

DVD-ROM optical drive 700845-001

Hard drives 

750-GB, 7200-rpm (2.5-in) 633252-001

750-GB, 5400 rpm (2.5-in) 634250-001

640-GB, 5400-rpm (2.5-in) 669300-001

500-GB, 7200 rpm (2.5 in) 634925-001

320-GB, 7200-rpm (2.5 in) 641672-001

Hard Drive Hardware Kit (includes hard drive bracket, mylar insulator, and screws) 683488-001

Miscellaneous parts

Description Spare part number

AC adapters

65-W AC adapter, non-PFC 693711-001

90-W AC adapter, PFC 693712-001

Power cords:

For use in Argentina 490371-D01

For use in Denmark 490371-081

For use in Europe, the Middle East, and Africa 490371-021

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in South Africa 490371-AR1

For use in Switzerland 490371-111

For use in the United Kingdom 490371-031

For use in the United States 490371-001

Rubber Kit (includes 10ea LCD rubbers and lower case rubbers) 683503-001

Screw Kit (includes 15 ea all screws) 683504-001

HP keyed cable lock 626729-001

Mouse, optical, 2-button 390632-001
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Description Spare part number

HP optical travel mouse 434594-001

Professional slim, top load case 592923-001

Notebook combination lock 591699-001

Essential top load case 679921-001

Nylon case 612757-001

Sequential part number listing
CSR flag designations:

A = Mandatory

B = Optional

C = Service technician recommended

N = Non-user replaceable

Spare part
number

CSR flag Description

390632-001 A Mouse, optical, 2-button

434594-001 A HP optical travel mouse

490371-001 A Power cord for use in North America

490371-021 A Power cord for use in Europe, the Middle East, and Africa

490371-031 A Power cord for use in the United Kingdom

490371-061 A Power cord for use in Italy

490371-081 A Power cord for use in Denmark

490371-111 A Power cord for use in Switzerland

490371-291 A Power cord for use in Japan

490371-AR1 A Power cord for use in South Africa

490371-BB1 A Power cord for use in Israel

490371-D01 A Power cord for use in Argentina

591699-001 A Notebook combination lock

592923-001 A Professional slim, top load case

612757-001 A Nylon case

626729-001 A HP keyed cable lock

633252-001 A 750-GB, 7200-rpm hard drive, (2.5-in)

633805-001 A 6-cell, 47 WHr, 2.2 Ah Li-ion battery

633809-001 A 9-cell, 93 WHr, 2.8 Ah Li-ion battery
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Spare part
number

CSR flag Description

634250-001 A 750-GB, 5400 rpm hard drive (2.5 in)

634925-001 A 500-GB, 7200 rpm hard drive (2.5 in)

641369-001 A 4-GB memory module (PC3-12800, 1600 MHz, DDR3)

641672-001 A 320-GB, 7200-rpm hard drive (2.5 in)

647675-001 N Microphone module

652972-001 A 2-GB memory module (PC3-12800, 1600 MHz, DDR3)

655795-001 A Atheros 9485GN 802.11 b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter

657325-001 A Broadcom 4313GN 802.11 b/g/n 1x1 WIFi and 20702 Bluetooth 4.0 Combo Adapter

669300-001 A 640-GB, 5400 rpm (2.5-in) hard drive

670691-001 A Ralink RT5390F 802.11 b/g/n 1x1 PCIe C

675794-001 A Atheros AR9485 802.11b/g/n WiFi Adapter

676786-001 A Atheros AR9462 802.11 a/b/g/n 2x2 Bluetooth 4.0 Combo

679921-001 A Essential top load case

683047-001 N AMD processor A6-4400M (3.2-GHz/2.7-GHz, 1-MB L2 cache)

683048-001 N AMD processor A8-4500M (2.8-GHz/1.9-GHz, 4-MB L2 cache)

683475-001 N Audio board

683476-001 N Base enclosure

683477-001 N Cable kit includes audio cable, DC-in cable, battery cable, and USB module with cable

683478-001 N Display bezel with webcam

683479-001 N Display bezel without webcam

683480-001 N Display hinges with left and right plastic hinge covers and LCD rubbers

683484-001 N Fan

683485-001 N Fingerprint reader module with cable

683486-001 N Power button board with cable

683487-001 N Hard drive extender board

683488-001 A Hard drive hardware kit includes hard drive bracket, mylar insulator, and screws

683491-001 A Keyboard with TouchPad for use in the United States, Windows 7

683491-031 A Keyboard with TouchPad for use in the United Kingdom, Windows 7

683491-041 A Keyboard with TouchPad for use in Germany, Windows 7

683491-051 A Keyboard with TouchPad for use in France, Windows 7

683491-061 A Keyboard with TouchPad for use in Italy, Windows 7

683491-071 A Keyboard with TouchPad for use in Spain, Windows 7

683491-131 A Keyboard with TouchPad for use in Portugal, Windows 7

683491-141 A Keyboard with TouchPad for use in Turkey, Windows 7
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Spare part
number

CSR flag Description

683491-151 A Keyboard with TouchPad for use in Greece, Windows 7

683491-161 A Keyboard with TouchPad for use in Latin America, Windows 7

683491-171 A Keyboard with TouchPad for use in Saudi Arabia, Windows 7

683491-211 A Keyboard with TouchPad for use Hungary, Windows 7

683491-251 A Keyboard with TouchPad for use in Russia, Windows 7

683491-261 A Keyboard with TouchPad for use in Bulgaria, Windows 7

683491-271 A Keyboard with TouchPad for use in Romania, Windows 7

683491-291 A Keyboard with TouchPad for use in Japan, Windows 7

683491-A41 A Keyboard with TouchPad for use in Belgium, Windows 7

683491-B31 A Keyboard with TouchPad for use in the Netherlands and Europe, Windows 7

683491-BA1 A Keyboard with TouchPad for use in Slovakia, Windows 7

683491-BB1 A Keyboard with TouchPad for use in Israel, Windows 7

683491-BG1 A Keyboard with TouchPad for use in Switzerland, Windows 7

683491-DB1 A Keyboard with TouchPad for use in Canada/English, Windows 7

683491-DD1 A Keyboard with TouchPad for use in Iceland, Windows 7

683491-DH1 A Keyboard with TouchPad for use in the Netherlands, Windows 7

683491-FL1 A Keyboard with TouchPad for use in the Czech Republic and Slovakia, Windows 7

683491-FP1 A Keyboard with TouchPad with TouchPad for use in Africa–French, Windows 7

683498-001 N ODD extender board

683499-001 N Blu-ray BD-R/RE DVD±RW SuperMulti DL Drive

683500-001 N DVD ROM Drive SuperMulti

683501-001 N Plastics Kit, includes bottom door, Secure digital card protective insert, and ODD protective insert

683503-001 N Rubber kit includes 5 ea LCD rubbers and lower case rubbers

683504-001 N Screw kit includes 15 ea all screws

683505-001 N Speaker assembly

683506-001 N Top cover with touchpad and fingerprint reader

683507-001 N Top cover with TouchPad without fingerprint reader

683508-001 N Webcam module

683596-001 N Display, hinge-up assy, 39.6-cm (15.6-in) HD Anti-glare without web cam

683597-001 N Display, hinge-up assy, 39.6-cm (15.6-in) HD Anti-glare with web cam

683598-001 N System board for use in models with 1-GB of discrete memory using Windows 7

683598-501 N System board for use in models with 1-GB of discrete memory using Windows 8 Std

683598-601 N System board for use in models with 1-GB of discrete memory using Windows 8 Pro

683599-001 N System board for use in models with 2-GB of discrete memory using Windows 7
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Spare part
number

CSR flag Description

683599–501 N System board for use in models with 2-GB of discrete memory using Windows 8 Std

683599–601 N System board for use in models with 2-GB of discrete memory using Windows 8 Pro

683600-001 N System board for use in models with UMA graphics using Windows 7

683600-501 N System board for use in models with UMA graphics using Windows 8 Std

683600-601 N System board for use in models with UMA graphics using Windows 8 Pro

683601-001 N RTC battery

683602-001 N Heat sink for use in models with discrete graphics

683603-001 N Heat sink for use in models with UMA graphics

685990-001 N Processor, AMD A4-4300M (3.0-GHz/2.5-GHz, 1-MB L2 cache)

687696-001 N Metal heat shield for 39.6-cm (15.6-in) models

690019-001 A WLAN, Atheros AR9565 802.11 b/g/n 1x1 WiFi with Bluetooth 4.0 Combo Adapter

690020-001 A WLAN, Ralink RT3290LE 802.11 b/g/n WiFi with Bluetooth 4.0 Combo Adapter

690978-001 A Bottom door

691415-001 A WLAN, Ralink RT5390R 802.11 b/g/n 1x1 WiFi Adapter

693711-001 A 65W non-PFC power adapter

693712-001 A 90W PFC power adapter

700845-001 A Optical drive , DVD-ROM

702237-001 A Keyboard with TouchPad for use in the United States with Windows 8

702237-031 A Keyboard with TouchPad for use in the United Kingdom with Windows 8

702237-041 A Keyboard with TouchPad for use in Germany with Windows 8

702237-051 A Keyboard with TouchPad for use in France with Windows 8

702237-061 A Keyboard with TouchPad for use in Italy with Windows 8

702237-071 A Keyboard with TouchPad for use in Spain with Windows 8

702237-131 A Keyboard with TouchPad for use in Portugal with Windows 8

702237-141 A Keyboard with TouchPad for use in Turkey with Windows 8

702237-151 A Keyboard with TouchPad for use in Greece with Windows 8

702237-161 A Keyboard with TouchPad for use in Latin America with Windows 8

702237-171 A Keyboard with TouchPad for use in Saudi Arabia with Windows 8

702237-211 A Keyboard with TouchPad for use in Hungary with Windows 8

702237-251 A Keyboard with TouchPad for use in Russia with Windows 8

702237-261 A Keyboard with TouchPad for use in Bulgaria with Windows 8

702237-271 A Keyboard with TouchPad for use in Romania with Windows 8

702237-291 A Keyboard with TouchPad for use in Japan with Windows 8

702237-A41 A Keyboard with TouchPad for use in Belgium with Windows 8
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Spare part
number

CSR flag Description

702237-B31 A Keyboard with TouchPad for use in the Netherlands and Europe with Windows 8

702237-BA1 A Keyboard with TouchPad for use in Slovakia with Windows 8

702237-BB1 A Keyboard with TouchPad for use in Hebrew with Windows 8

702237-BG1 A Keyboard with TouchPad for use in Switzerland with Windows 8

702237-DB1 A Keyboard with TouchPad for use in Canada/English with Windows 8

702237-DD1 A Keyboard with TouchPad for use in Iceland with Windows 8

702237-DH1 A Keyboard with TouchPad for use in the Netherlands with Windows 8

702237-FL1 A Keyboard with TouchPad for use in the Czech Republic and Slovakia with Windows 8

702237-FP1 A Keyboard with TouchPad for use in Africa-French with Windows 8
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Preliminary replacement requirements 31



Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, and then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tapes

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 95 screws and screw locks, in 15 different sizes, that must be removed,
replaced, or loosened when servicing the computer. Make special note of each screw and screw lock
size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

● Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.
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Battery

Description Spare part number

9-cell, 93 WHr, 2.8 Ah Li-ion battery 633809-001

6-cell, 47 WHr, 2.2 Ah Li-ion battery 633805-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface with the battery bay away from you.

2. Slide the battery release latches (1) to release the battery.

3. Pivot the battery (2) upward to remove it from the computer (3).

Install the battery by inserting it into the battery bay until you hear a click.
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Bottom door

Description Spare part number

Bottom door 690978-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

Remove the bottom door:

1. Position the computer upside-down on a flat surface with the battery bay toward you.

2. Remove the locking screw (if installed) (1) and slide the two bottom door release latches (2) to
release the door.

3. Slide the door toward the front of the computer (3), and then lift the door off the computer (4).

Reverse the removal procedures to install the bottom door.
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Bottom parts location

Some customer replaceable parts are accessible after removing the bottom door.

Item Description

1 Memory module

2 Hard drive

3 WLAN module

WLAN/Bluetooth combo card

The computer uses a card that provides both WLAN and Bluetooth functionality.

CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Atheros 9485GN 802.11 b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001

Atheros AR9485 802.11 b/g/n 1x1 WiFi Adapter HMC 675794-001

Atheros AR9462 802.11 a/b/g/n 2x2 Bluetooth 4.0 Combo 676786-001

Atheros AR9565 802.11 b/g/n with Bluetooth 4.0 Combo Adapter 690019-001

Broadcom 4313GN 802.11 b/gn 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

Rallink RT5390F 802.11 b/g/n 1x1 PCIe C 670691-001

Ralink RT3290LE 802.11 b/g/n 1x1 WiFi and Bluetooth 4.0 Combo Adapter 690020-001

Ralink RT5390R 802.11 b/g/n 1x1 WiFi Adapter 691415-001
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Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the bottom door (see Bottom door on page 38).

Remove the WLAN module:

1. Position the computer upside-down with the battery bay away from you.

2. Locate and remove the mylar protector glued to the base enclosure (see bottom parts
locationBottom parts location on page 39) to access the WLAN card.

3. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN
antenna cable connects to the middle terminal on the WLAN module.

4. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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5. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch  to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following
illustration.

Reverse this procedure to install the WLAN module.

Optical drive

NOTE: All optical drive spare part kits include an optical drive bezel and a bracket with mounting
screws.

Description Spare part number

Blu-ray BD-R/RE DVD±RW SuperMulti DL Drive (includes bracket and screws) 683499-001
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Description Spare part number

DVD±RW and CD-RW SuperMulti DL Combo Drive (includes bracket and screws) 683500-001

DVD-ROM drive 700845-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the bottom door (see Bottom door on page 38).

Remove the optical drive:

1. Position the computer upside-down with the battery bay away from you.

2. Remove the Phillips PM2.5×5.0 screw (1) that secures the optical drive to the computer.

3. Push the optical drive tab (2) to release the optical drive from the computer.
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4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.

6. Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

Component replacement procedures 43



7. Remove the optical drive bracket (2).

Reverse this procedure to install an optical drive.
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Hard drive

Description Spare part number

750-GB, 7200-rpm (2.5 in) 633252-001

750-GB, 5400-rpm (2.5 in) 634250-001

640-GB, 5400-rpm (2.5 in) 669300-001

500-GB, 7200 rpm (2.5 in) 634925-001

320-GB, 7200-rpm (2.5 in) 641672-001

Hard Drive Hardware Kit (includes hard drive bracket, mylar insulator, and screws) 690978-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the bottom door (see Bottom door on page 38).

Remove the hard drive:

1. Position the computer upside-down with the front toward you.

2. Locate the hard drive on the bottom of the computer (see bottom parts location Bottom parts
location on page 39)

3. Remove the four Phillips PM2.0×4.0 screws (1) that secure the hard drive to the computer.
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4. Grasp the Mylar cover on the hard drive and slide the hard drive to the left (2) to disconnect it
from the system board connector and lift it from the hard drive bay. .

5. If it is necessary to replace the hard drive bracket, unwrap the mylar cover (1) that surrounds the
drive. 

6. Remove the two Phillips PM3.0×3.0 hard drive bracket screws (2) from each side of the hard
drive (4 total screws).

7. Lift the mounting bracket from around the hard drive (3).
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8. Lower the mylar protector from the assembly (4).

Reverse this procedure to reassemble and install the hard drive.

Keyboard

NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 26.

Description Spare part number

Keyboard for use with models using Windows 7 683491-xxx

Keyboard for use with models using Windows 8 702237-xxx

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the bottom door (see Bottom door on page 38).

6. Remove the Optical drive (see Optical drive on page 41).

Component replacement procedures 47



Remove the keyboard:

1. Position the computer upside-down with the front toward you.

2. Remove the three Phillips PM2.5×6.0 screws that secure the keyboard to the computer.

3. Position the computer on its side with the bottom facing you and the computer open.

4. Insert a screwdriver or similar tool in the Optical drive compartment and push to disengage the
keyboard.

5. Position the computer upright with the front toward you.

6. Open the computer as far as possible.
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7. Slide the keyboard towards you (1), then lift the keyboard from the top (2) and pull it out of the
top cover (3).

8. Rotate the keyboard (1) to access the cable connector.

9. Release the cable locking device (2) and remove the cable (3). The keyboard may now be set
aside.

Reverse this procedure to install the keyboard.
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Memory modules

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of the
computer.

Description Spare part number

2-GB (PC3-12800, 1600-MHz, DDR3) 652972-001

4-GB (PC3-12800, 1600-MHz, DDR3) 641369-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then click
Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the bottom door (see Bottom door on page 38).

6. Locate the memory module (see Bottom parts location Bottom parts location on page 39)

Remove the memory module:

1. Position the computer upside-down with the battery bay toward you.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

NOTE: The computer uses two memory sockets. The top socket houses the expansion
memory module and is shown in the following image. The bottom socket houses the primary
memory module. The removal procedure is the same for both memory sockets.

Reverse this procedure to install a memory module.

Metal heat shield

Before removing the metal heat shield, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the bottom door (see Bottom door on page 38).

Remove the metal heat shield:

1. Position the computer upside-down with the battery bay away from you.

2. Remove the one Phillips screw (1) in the middle of the shield that secures the keyboard and the
two screws (1) that hold the edges of the shield in place.
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3. Slide the shield to the left (2), then rotate the shield up (3) and remove it (4) from the base
enclosure .

Reverse this procedure to install the metal heat shield.
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Fan

Description Spare part number

Fan 646285-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Metal heat shield (see Metal heat shield on page 51).

Remove the fan:

1. Position the computer upside-down with front towards user.

2. Disconnect the fan cable (1) from the system board.

3. Remove the single Phillips PM2.5×6.0 screw (2) that secures the fan to the system board.

4. Rotate and lift the fan (3) from the system board.

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-in) clearance on the left side of
the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are
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affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is
displaced through the ventilation grill located on the left side of the computer.

Heat sink

All heat sink spare part kits include replacement thermal material.

Description Spare part number

Heat sink for use in computers with discrete graphics 654310-001

Heat sink for use in computers with UMA graphics 654311-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Metal heat shield (see Metal heat shield on page 51).

c. Fan (see Fan on page 53).

Remove the discrete heat sink:

1. Position the computer upside down with battery bay away from you.

2. To remove the discrete heat sink, loosen the six captive Phillips screws (1) in the order indicated
on the components, that secure the heat sink to the system board.
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3. Rotate the heats sink up on the left end (2) and slide the heat sink to the left (3) to remove it
from the system board.

Remove the UMA heat sink.

1. Position the computer upside down with battery bay away from user.

2. To remove the discrete heat sink, loosen the four captive Phillips screws (1) in the order
indicated on the component, that secure the heat sink to the system board.

3. Lift the left end of the heat sink (2) and then slide the heat sink to the left to remove it from the
system board (3).

NOTE: For discrete models, thoroughly clean thermal material from the surface of the system board
(1) and (3) and from the heat sink components(2) and (4) each time you remove the heat sink. All
heat sink and processor spare part kits include thermal material.
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NOTE: For UMA models, thoroughly clean thermal material from the surface of the system board
(1) and from the heat sink (2) each time you remove the heat sink. All heat sink and processor spare
part kits include thermal material.

Reverse this procedure to install the heat sink.

Processor

NOTE: All processor spare part kits include replacement thermal material.

Description Spare part number

AMD A4-4300M APU (3.0-GHz/2.5-GHz, 1-MB L2 cache) 685990-001

AMD A6-4400M APU (3.2-GHz/2.7-GHz, 1-MB L2 cache) 683047-001

AMD A8-4500M APU (2.8-GHz/1.9-GHz, 4-MB L2 cache) 683048-001
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Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Metal heat shield (see Metal heat shield on page 51).

c. Fan (see Fan on page 53).

d. Heat sink (see Heat sink on page 54).

Remove the processor:

1. Position the computer upside-down with the front toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed
on the processor slot when you install the processor.

Reverse this procedure to install the processor.
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Top cover

Description Spare part number

For use in models with a fingerprint reader. Includes TouchPad assembly with cable and ESD
board with screw.

683506-001

For use in models without a fingerprint reader. Includes TouchPad assembly with cable, ESD
board with screw, fingerprint reader dummy with screws.

683507-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Optical drive (see Optical drive on page 41).

c. Hard drive (see Hard drive on page 45).

d. Keyboard (see Keyboard on page 47).

Remove the top cover:

1. Position the computer upside-down with the front toward you.
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2. Remove the following covers and screws that secure the top cover to the computer:

(1) 4 rubber screw covers

(2) 11 Torx T8M2.5×6.0 screws
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3. Remove the following screws that secure the top cover to the computer:

(1) Two Phillips PM2.0×4.0 screws from the optical drive bay

(2) Three Phillips PM2×2 broadhead screws from the battery bay

4. Turn the computer upright and open it as far as possible.

5. Remove the 2 Torx T8M2.5×6.0 screws that secure the top cover to the computer.
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6. Remove the following cables from the system board:

● Lift the connector latch and disconnect the function/power board cable (1)

● Disconnect the speaker cable (2)

● Lift the connector latch and disconnect the fingerprint reader board cable (3)

7. Position the computer on its side with the display open.
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8. Insert a screwdriver through the holes in the battery bay and press to disengage the top cover
from the computer.

9. Position the computer upright with the front toward you.
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10. To remove the top cover, pull up on the top of the top cover (1), pull upward on the left (2) and
right sides (3), and then lift the bottom of the top cover (4) to remove it enough to access the
card reader cable underneath.

11. Lift the front of the top cover slightly to gain access to the cable and connector underneath.

12. Lift the connector latch (1), disconnect the card reader cable (2), and then lift the top cover from
the computer (3).

Reverse this procedure to install the top cover.
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Audio board

Description Spare part number

Audio board 683475-001

Before removing the audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Optical drive (see Optical drive on page 41).

c. Hard drive (see Hard drive on page 45).

d. Keyboard (see Keyboard on page 47).

e. Metal heat shield (see Metal heat shield on page 51).

f. Top cover (see Top cover on page 58)

Remove the audio board:

1. Position the top cover upside-down with the front toward you.

2. Disconnect the audio board cable (1).

3. Remove the 2 Phillips PM2.5×5.0 screws (2) that secure the audio board to the top cover.
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4. Rotate the audio board upward (3) to remove it.

Reverse this procedure to install the card reader.

Speaker assembly

Description Spare part number

Speaker assembly (includes housing) 683505-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Optical drive (see Optical drive on page 41).

c. Keyboard (see Keyboard on page 47).

d. Metal heat shield (see Metal heat shield on page 51).

e. Top cover (see Top cover on page 58).
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Remove the speaker assembly:

1. Position the top cover upside-down with the front toward you.

2. Remove the speaker cable (1) from the wire channel.

3. Remove the two Phillips PM2.0×4.0 screws (2) that secure the speakers to the computer.

4. Lift the two speakers from the top cover (3).

Reverse this procedure to install the speaker assembly.

Power button board/Function board assembly

Description Spare part number

Power button board/function board 683486-001

Before removing the power button board/function board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Optical drive (see Optical drive on page 41).
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c. Keyboard (see Keyboard on page 47).

d. Metal heat shield (see Metal heat shield on page 51).

e. Top cover (see Top cover on page 58).

Remove the power button board/function board:

1. Position the top cover upside-down with the front toward you.

2. Remove one Phillips PM2.0×4.0 screw (1) on both the power button board and the function
board to the top cover.

3. Lift the power button board (2) and the function board (3) from the top cover

Reverse this procedure to install the power button board/function board.

Fingerprint board

Description Spare part number

Fingerprint board. Includes cable, mounting bracket, and retaining screw. 683485-001

Before removing the fingerprint board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Optical drive (see Optical drive on page 41).

c. Keyboard (see Keyboard on page 47).

d. Metal heat shield (see Metal heat shield on page 51).

e. Top cover (see Top cover on page 58).

Remove the fingerprint board:

1. Position the top cover upside-down with the front toward you.

2. Remove the screw (1) that secures the fingerprint board to the top cover.

3. Remove the fingerprint board retainer (2).

4. Lift the cable (3) that is attached to the top cover with adhesive from the top cover and then
remove the fingerprint reader (4).

Reverse this procedure to install the fingerprint board.
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USB board

Description Spare part number

USB board Part of Spare Cable kit 683477-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Optical drive (see Optical drive on page 41).

c. Metal heat shield (see Metal heat shield on page 51).

d. Keyboard (see Keyboard on page 47)

e. Top cover (see Top cover on page 58).

Remove the USB board:

1. Position the computer upright with the front toward you.

2. Disconnect the USB board cable from the system board (1) and remove the cable (2) from the
cable run.

3. Remove the Phillips PM2.5×5.0 screw (3) that secures the USB board to the computer.
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4. Lift the board and cable straight up out of the computer (4).

Reverse this procedure to install the USB board.

System board

NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

Systems boards for use in models without Windows 8:

1-GB of discrete memory 683598-001

2-GB of discrete memory 683599-001

Shared video memory with UMA graphics 683600-001

Systems boards for use in Windows 8 models:

1-GB of discrete memory 683598-501

1-GB of discrete memory 683598-601

2-GB of discrete memory 683599-501

2-GB of discrete memory 683599-601

Shared video memory UMA graphics 683600-501

Shared video memory with UMA graphics 683600-601
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Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Hard drive (see Hard drive on page 45).

c. Optical drive (see Optical drive on page 41).

d. WLAN/Bluetooth combo card (see WLAN/Bluetooth combo card on page 39).

e. Keyboard (see Keyboard on page 47).

f. Metal heat shield (see Metal heat shield on page 51).

g. Top cover (see Top cover on page 58).

When replacing the system board, be sure to remove the following components from the defective
system board and install on the replacement system board:

● Memory module (see Memory modules on page 50).

● WLAN card(see WLAN/Bluetooth combo card on page 39).

● Fan (see Fan on page 53).

● Heat sink (see Heat sink on page 54).

● Processor (see Processor on page 56).

Remove the system board:

1. Position the computer upright with the front toward you.

2. Disconnect the main power cable (1).

3. Disconnect the graphics cable (2) from the system board.
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4. Disconnect the USB board cable (3) from the system board.

5. Disconnect the battery cable (1) from the underside of the system board. 

6. Remove the two screws (2) that secure the battery cable connector to the base enclosure and
remove the connector (3).

7. Remove the four screws (1) that secure the system board and the drive extenders to the base
enclosure.
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8. Lift the system board (2) up on its right end and remove it from the computer .

Reverse this procedure to install the system board.

RTC battery

Description Spare part number

RTC battery 683601-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Hard drive (see Hard drive on page 45).

c. Optical drive (see Optical drive on page 41).

d. Metal heat shield (see Metal heat shield on page 51).

e. Fan (see Fan on page 53).

f. Heat sink (see Heat sink on page 54).

g. Keyboard (see Keyboard on page 47).
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h. Top cover (see Top cover on page 58).

i. System board (see System board on page 70).

Remove the RTC battery:

1. Position the system board upside-down with the front toward you.

2. Use a screwdriver to loosen the battery from the slot (1).

3. Lift the battery from the system board (2).

Reverse this procedure to install the RTC battery.

Power cable

The power cable is included in the Cable Kit, spare part number 683477-001.

Before removing the power cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Hard drive (see Hard drive on page 45).

c. Optical drive (see Optical drive on page 41).

d. Metal heat shield (see Metal heat shield on page 51).
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e. Fan (see Fan on page 53).

f. Heat sink (see Heat sink on page 54).

g. Keyboard (see Keyboard on page 47).

h. Top cover (see Top cover on page 58).

i. System board (see System board on page 70).

Remove the power cable:

1. Position the system upright with the front toward you.

2. Disconnect the cable (1) from the bottom of the system board .

3. Lift the power cable assembly (2) from the computer .

Reverse this procedure to install the power cable.
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Drive extenders

Description Spare part number

Optical drive extender 683498-001

Hard drive extender 683487-001

Before removing the drive extenders, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Optical drive (see Optical drive on page 41).

c. Hard drive (see Hard drive on page 45).

d. Metal heat shield (see Metal heat shield on page 51).

e. Fan (see Fan on page 53).

f. Heat sink (see Heat sink on page 54).

g. Keyboard (see Keyboard on page 47).

h. Top cover (see Top cover on page 58).

i. System board (see System board on page 70).

Remove the hard drive extender:

1. Position the system board with the drive extenders to your right.
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2. Pull the hard drive extender straight out of the system board.

Reverse this procedure to install the hard drive extender.

Remove the optical drive extender:

1. Position the system board with the drive extenders to your right.

2. Pull the optical drive extender straight out of the system board.

Reverse this procedure to install the optical drive extender.

Display assembly

All display assemblies include WLAN antenna transceivers and cables.

All display spare parts are shown in the following table:
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Description Spare part number

Complete hinge–up display assembly, 39.6-cm (15.6-inch) HD, Anti-glare, without webcam 683596-001

Complete hinge–up display assembly, 39.6-cm (15.6-inch) HD, Anti-glare, with webcam 683597-001

Display bezel 39.6-cm (15.6-inch), without webcam and LCD rubbers 683479-001

Display bezel 39.6-cm (15.6-inch), with webcam and LCD rubbers 683478-001

Display hinges, includes plastic hinge covers and LCD rubbers 683480-001

Webcam 683508-001

Microphone 647675-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 37).

5. Remove the following components:

a. Bottom door (see Bottom door on page 38).

b. Optical drive (see Optical drive on page 41).

c. WLAN module (see WLAN/Bluetooth combo card on page 39).

d. Keyboard (see Keyboard on page 47).

e. Metal heat shield (see Metal heat shield on page 51).

f. Fan (see Fan on page 53).

g. Heat sink (see Heat sink on page 54).

h. Top cover (see Top cover on page 58).

i. System board (see System board on page 70).

Remove the display assembly:

1. Position the computer upright with the front toward you.

2. Open the computer as far as possible.
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3. Remove the WLAN cable from the cable raceway (1) and from the cable clips (2).

4. Remove the display cable (1) from the raceway and release them from the cable clips (2).

5. Remove two Torx T8M2.5×7.0 screws from each of the two hinges (1).
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6. Lift the display from the computer (2).

7. If you need to remove the hinge covers from the display hinges, pull the hinges straight up and
off the display to remove them.

Display hinge covers are spared with the Display hinge kit, spare part number 683480-001.
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8. To replace the display bezel, remove the two rubber screw covers (1) and the two Torx
T8M2.5×6.0 screws (2) in the bottom corners of the display bezel.

9. Flex the top (3) of the bezel, the inside edges of the left and right sides (4), and then the bottom
(5) of the bezel until it disengages from the display enclosure. Remove the display bezel.

The bezel is available using the following spare part numbers:

683596-001: models without a webcam

683597-001: models with a webcam
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10. If it is necessary to replace the webcam module (shown in the following image) or microphone
module from the display enclosure, gently pull the module away from the double-sided tape on
the display enclosure (1) and disconnect the cable from the module (2).

The webcam module is available using spare part number 683508-001.

The microphone module is removed using the same procedure and is available using spare part
number 647675-001.

11. If it is necessary to replace the display hinges, remove the Phillips PM2.5×3.0 screws (1) that
secure each display hinge to the display panel.

12. Remove the display hinges (2).

Display hinges are available using spare part number 646279-001.
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Reverse the process to install the display hinges.
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5 Computer Setup (BIOS) and Advanced
System Diagnostics

Windows 7 – Computer Setup (BIOS) and Advanced
System Diagnostics

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Updating the BIOS

The next sections describe different ways of updating the BIOS.

Downloading SoftPaqs to update the BIOS

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

To install BIOS updates from the HP website, follow the steps below:

1. Download the SoftPaq from the HP website.

2. Click Run, and then follow the on-screen instructions to update the BIOS.
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NOTE: Some download packages contain a file named Readme.txt, which contains information
regarding installing and troubleshooting the file.

BIOS management using system diagnostics

1. Download the SoftPaq from the HP website.

NOTE: Verify that the UEFI system diagnostics is installed on your computer (or USB flash
drive).

2. Click Run, and then click Cancel at the Update/USB bootable dialog box.

3. Navigate to the folder located in c:\swsetup that corresponds to your SoftPaq number.

4. Locate the .bin file in the ROMpaq folder (for example, 68CDD.bin) and then copy it to the
Hewlett-Packard\BIOS\New\ folder in either the HP_Tools partition of the hard drive, or the USB
flash drive.

5. Locate the .sig file in the ROM.cab file and rename it with the same prefix as the .bin file (for
example, 68CDD.sig). Copy the renamed file to the Hewlett-Packard\BIOS\New\ folder in either
the HP_Tools partition of the hard drive, or the USB flash drive.

6. Restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

7. Press f2 to enter Computer Setup.

8. Click BIOS Management from the menu and then select Update BIOS.

Using f10 setup to update the BIOS

1. Download the SoftPaq from the HP website.

NOTE: Verify that the UEFI system diagnostics is installed on your computer (or USB flash
drive).

2. Click Run, and then click Cancel at the Update/USB bootable dialog box.

3. Navigate to the folder located in c:\swsetup that corresponds to your SoftPaq number.

4. Locate the .bin file in the ROMpaq folder (for example, 68CDD.bin) and then copy it to the
Hewlett-Packard\BIOS\New\ folder in either the HP_Tools partition of the hard drive, or the USB
flash drive.

5. Locate the .sig file in the ROM.cab file and rename it with the same prefix as the .bin file (for
example, 68CDD.sig). Copy the renamed file to the Hewlett-Packard\BIOS\New\ folder in either
the HP_Tools partition of the hard drive, or the USB flash drive.

6. Restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

7. Press f10 to enter Computer Setup.

8. Click Update System BIOS, and then click Accept to update the BIOS.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.
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BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Select Start > Help and Support > Maintain.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > Computer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.
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NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

BIOS Setup Menu

The tables in this section provide an overview of the BIOS Setup menu options.

Main menu

Select To do this

System information ● View and change the system time and date.

● View identification information about your computer.

● View specification information about the processor,
memory size, and system BIOS.

Security menu

Select To do this

Administrator password Control access to Setup Utility.

Power-on password Control access to your computer.

Diagnostics menu

Select To do this

Primary Hard Disk Self Test Run a quick or comprehensive self-test on the hard drive.

Memory Test Run a diagnostic test on the system memory.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.
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● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact support to report the issue and purchase a
replacement battery.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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Windows 8 – Computer Setup (BIOS) and Advanced
System Diagnostics

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Computer Setup menus:
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Click the Save icon in the lower-right corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –
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Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type help and then select Help and Support.

2. In the Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type windows explorer, and then click Windows Explorer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

● BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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SUSE Linux– Computer Setup (BIOS) and Advanced
System Diagnostics

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

● To save your changes and exit Computer Setup menus:
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Click the Save icon in the lower-right corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

SUSE Linux– Computer Setup (BIOS) and Advanced System Diagnostics 95



Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type help and then select Help and Support.

2. In the Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type windows explorer, and then click Windows Explorer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

96 Chapter 5   Computer Setup (BIOS) and Advanced System Diagnostics



Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact support to report the issue and purchase a
replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Length 25.6 cm 10.1 in

Width 37.5 cm 14.8 in

Height (front to rear) 2.9 to 3.6 cm 1.1 to 1.4 in

Weight (equipped with optical drive, 1 DIMM, hard drive,
optical drive, WLAN module, 6 cell battery)

2.5 kg 5.5 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 90 W or 18.5 V dc @ 3.5 A - 65 W

Operating current 4.74 A or 3.5 A

Temperature

Operating (not writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.
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39.6-cm (15.6-in), HD display specifications

 Metric U.S.

Active diagonal size 39.6-cm 15.6-in

Resolution 1366x768 (HD)

Active area 344.232x193.536

PPI 100

Surface treatment Anti-glare or BrightView

Contrast ratio 300:1 (typical) – Anti-glare

500:1 – BrightView

Response time 8 ms

Brightness 200 nits (typical)

Viewing angle SVA

Backlight LED

Luminance uniformity @ 13 points 1.4 (typ), 1.6 (max)

Lifetime (1/2 luminance) 12,000 hours

Color coordinate (white) (0.313, 0.329)

Color tolerance (White) +/- 0.02

Color tolerance (R, G, B) +/- 0.03

Color gamut 60% (typical)
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Hard drive specifications

 750-GB* 640-GB* 500-GB* 320-GB* 250-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm 70 mm

Weight 115 g 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 2 ms 3 ms 3 ms 3 ms

Average 11 ms 12 ms 13 ms 13 ms 13 ms

Maximum 14 ms 22 ms 24 ms 24 ms 24 ms

Logical blocks 1,465,149,168 1,250,263,728 1,048,576,000 625,141,400 488,397,168

Disc rotational speed 7200 rpm 7200 rpm or 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Blu-ray BD-R/RE DVD±RW SuperMulti DL Drive
specifications

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD (Photo-
CD, CD-EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM
(DVD-5, DVD-9, DVD-10, DVD-18),
DVD-R, DVD-RW, DVD+R, DVD+RW.
DVD-RAM, BD-ROM, BD-R, BD-RE

CD-R, CD-RW, DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9), DVD-RW,
DVD-RAM, BD-R, BD-RE

Access time CD DVD BD-ROM

Random <180 ms <180 ms <230 ms

Maximum Media Capacity (read) 50 GB

Maximum Media Capacity (write) 8.5 GB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

2X BD-ROM 9,000 KB/sec

16X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

6X DVD+RW 8,100 KB/sec

8X DVD-R 10,800 KB/sec

6X DVD-RW 8,100 KB/sec

4X DVD+R Dual Layer 5,400 KB/sec

4X DVD-R Dual Layer 5,400 KB/sec

5X DVD-RAM 6,750 KB/sec

2X BD-R 9,000 KB/sec

2X BD-RE 9,000 KB/sec
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DVD±RW and CD-RW SuperMulti DL Combo Drive
specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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Blu-ray Disc ROM with SuperMulti DVD±R/RW DL Drive

Applicable disc Read: Write:

 CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-
ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time CD DVD HD

Random 170 ms 170 ms 230 ms

Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

1X BD-ROM 4,500 KB/sec

1X BD-R read 4,500 KB/sec

1X BD-RE read 4,500 KB/sec

Transfer mode Multiword DMA Mode

Blu-ray Disc ROM with SuperMulti DVD±R/RW DL Drive 103



DVD-ROM Drive specifications

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital
Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter  

Standard disc

Mini disc

12 cm (4.72 in)

8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 100 ms < 125 ms

Full stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate  

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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Specification information in Device Manager
Device Manager allows you to view and control the hardware attached to the computer, as well as
provides hardware specification information.

You can also add hardware or modify device configurations using Device Manager.

NOTE: Windows 7 includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.

After you open Device Manager, drill-down to a device and double-click it to access its properties.

To access Device Manager in Windows 8:

1. From the Start screen, type control, and then select Control Panel.

2. Select System and Security, and the in the System area, click Device Manager.

To access Device Manager in Windows 7:

1. Select Start > Computer > System properties.

2. In the left pane, click Device Manager.
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7 Backup and recovery

Windows 7 - Backup and recovery

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only)
with the installed optical drive (select models only) or an optional external optical drive, or create
system restore points. In case of system failure, you can use the backup files to restore the contents
of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP
Recovery Disc Creator. This recovery media allows you to reinstall your original operating system as
well as select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver Disc or Windows Disc.

3. From the drop-down menu, select the drive for creating the recovery media.

4. Click the Create button to start the burning process.

Backing up your information

Recovery after a system failure is as good as your most recent backup. Immediately after setting up
the computer, you should create system repair discs (select models only) using the installed optical
drive (select models only) or an optional external optical drive and back up your system. As you add
new software and data files, you should continue to back up your system on a regular basis to
maintain a reasonably current backup. The system repair discs (select models only) are used to start
up (boot) the computer and repair the operating system in case of system instability or failure. Your
initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive you are using.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.
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NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, see the
Using a Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the
hard drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.

3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11>” for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http://www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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Windows 8 - Backup and recovery
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of your
computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed
options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information. From the Start screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system
repair media and your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair media (select models only) are used to start up (boot)
the computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

On Start screen, type backup, click Settings, and then select Save backup copies of your files
with File History.

You can back up your information to an optional external hard drive or a network drive.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).
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Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see

Using the Windows recovery tools

To recover information you previously backed up:

▲ From the Start screen, type h, and then select Help and Support.

To recover your information using Automatic Repair, follow these steps:

CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. All
files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition.

From the Start screen, type e, and then click File Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see Using Windows 8
operating system media (purchased separately) on page 113.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart. The system will display
Continue/Troubleshoot/ Turn off your PC.

4. Select Troubleshoot. Advanced Options, and then Automatic Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select Help and
Support.
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Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type C,
and then select Computer.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system
media (purchased separately) on page 113.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.
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IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on
reinstalling traditional applications. From the Start screen, type h, and then select Help and Support.

NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select Help and
Support.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the on-
screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option
removes all personal data, apps, and settings from your computer, and reinstalls Windows.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.

To use the f11 key:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the
charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the on-
screen instructions.
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Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or
deleted from the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
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SUSE Linux - Backup and recovery
Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if
ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see
Performing a system recovery on page 117.

2. As you add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.

4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.

5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click Use the latest version to restore the
latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.
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Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an
HP Factory Image Restore DVD, using an installed or an external DVD±RW optical drive.

CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All
files you have created and any software installed on the computer are permanently removed. The
recovery tool reinstalls the original operating system and HP programs and drivers that were installed
at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled.
Personal files must be restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery
disc. To create the recovery disc:

NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a
system failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the right
pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot
menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-Restore?

6. Follow the on-screen instructions.

USB Recovery option (select models only)

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the
SUSE Linux operating system installed on select HP Business Notebooks. This Disk On Key may be
used to restore the system to the original factory state when the F11 recovery option is not available.
This process should be done on first obtaining the computer.

CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive
or on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the
notebook that will be recovered before starting.

NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure.
The Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

2. Select Computer > More applications > Tools > Create Recovery USB.

3. Enter the root password when prompted.

4. Select USB Disk On Key from the list.
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5. Click OK.

6. A question dialog will remind you that the data on the USB key will be destroyed. To continue,
click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another
computer.

7. The backup process will display a status dialog box while the backup is in progress.

NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the
key is mounted. You may close the file browser window if desired. Once the USB Recovery Key
has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

CAUTION: Before starting the Recovery process, make sure any data on the system to be
recovered has been backed up. The recovery process destroys all data on the system to be
recovered.

1. Turn off the computer.

2. Connect the USB Disk On Key to a USB port on the computer.

3. Turn on the computer while holding down the f9 key.

4. Once the system has booted, the Boot Options menu should appear.

5. Using the arrow keys, select USB Disk On Key and press enter.

NOTE: The description may vary from one USB key to another. Any entry other than Optical
Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On
Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk
On Key will boot.

7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start
the System-Restore?” If data on the computer has not been backed up, use the tab key and
select No. The system will reboot. Back up the system data and repeat the previous steps. If no
data should be saved from the computer, use the tab key to select Yes. Press enter to begin the
recovery process.

8. After the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall SUSE Linux

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option
removes all personal data, applications, and settings from your computer, and reinstalls the Linux
operating system.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.
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The following options are available:

● Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

● Recover/Repair System—This option repairs a system that is not working properly and
preserves user data.

● Restore Factory System—This option restores the system back to the original factory state. User
data is not preserved.

Select an option and follow the on-screen instructions.
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8 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts ac, or from 220 to 240 volts ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating
of 125 or 250 V ac, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Argentina IRAM 1

Australia SAA 1

Austria OVE 1

Belgium CEBEC 1

Brazil ABNT 1

Canada CSA 2

Chile IMQ 1

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

India ISI 1

Israel SII 1

Italy IMQ 1
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Country/region Accredited agency Applicable note number

Japan METI 3

The Netherlands KEMA 1

New Zealand SANZ 1

Norway NEMKO 1

The People's Republic of China CCC 4

Saudi Arabia SASO 7

Singapore PSB 1

South Africa SABS 1

South Korea EK 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 6

Thailand TISI 1

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SVT/SJT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL
mark. UL file number must be on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75mm² or 1.25mm² conductor size. The
wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type H)5VV-F3X0.75mm² conductor size. Power cord set fittings (appliance coupler and wall
plug) must bear the CCC certification mark.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75mm² conductor size. KTL logo and individual approval number
must be on each element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3X1.255mm² conductor size. Power cord set fittings (appliance coupler and wall
plug) must bear the CCC certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3X18 AWG with plug NEMA 5-15P (15 A, 125 V ac) with UL
and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type HOVV–F 3X0.75/1.00mm² conductor size, with
plug BS 1363/A with BSI or ASTA marks.
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9 Recycling

Battery
When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not
dispose of the battery in general household waste. Follow the local laws in your area for battery
disposal.

HP encourages customers to recycle used electronic hardware. HP original print cartridges and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the LCD panel and the backlight. When you remove
these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Position the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Position the display panel right-side up.

15. Remove the backlight cables (1) from the clip (2) in the display panel.
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16. Position the display panel upside-down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.

18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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